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© Cypress Semiconductor Corporation, 2011-2017. This document is the property of Cypress Semiconductor Corporation
and its subsidiaries, including Spansion LLC ("Cypress"). This document, including any software or firmware included or refer-
enced in this document ("Software"), is owned by Cypress under the intellectual property laws and treaties of the United
States and other countries worldwide. Cypress reserves all rights under such laws and treaties and does not, except as spe-
cifically stated in this paragraph, grant any license under its patents, copyrights, trademarks, or other intellectual property
rights. If the Software is not accompanied by a license agreement and you do not otherwise have a written agreement with
Cypress governing the use of the Software, then Cypress hereby grants you a personal, non-exclusive, nontransferable
license (without the right to sublicense) (1) under its copyright rights in the Software (a) for Software provided in source code
form, to modify and reproduce the Software solely for use with Cypress hardware products, only internally within your organi-
zation, and (b) to distribute the Software in binary code form externally to end users (either directly or indirectly through resell-
ers and distributors), solely for use on Cypress hardware product units, and (2) under those claims of Cypress's patents that
are infringed by the Software (as provided by Cypress, unmodified) to make, use, distribute, and import the Software solely
for use with Cypress hardware products. Any other use, reproduction, modification, translation, or compilation of the Software
is prohibited.

TO THE EXTENT PERMITTED BY APPLICABLE LAW, CYPRESS MAKES NO WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, WITH REGARD TO THIS DOCUMENT OR ANY SOFTWARE OR ACCOMPANYING HARDWARE, INCLUDING,
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PUR-
POSE. To the extent permitted by applicable law, Cypress reserves the right to make changes to this document without fur-
ther notice. Cypress does not assume any liability arising out of the application or use of any product or circuit described in
this document. Any information provided in this document, including any sample design information or programming code, is
provided only for reference purposes. It is the responsibility of the user of this document to properly design, program, and test
the functionality and safety of any application made of this information and any resulting product. Cypress products are not
designed, intended, or authorized for use as critical components in systems designed or intended for the operation of weap-
ons, weapons systems, nuclear installations, life-support devices or systems, other medical devices or systems (including
resuscitation equipment and surgical implants), pollution control or hazardous substances management, or other uses where
the failure of the device or system could cause personal injury, death, or property damage ("Unintended Uses"). A critical
component is any component of a device or system whose failure to perform can be reasonably expected to cause the failure
of the device or system, or to affect its safety or effectiveness. Cypress is not liable, in whole or in part, and you shall and
hereby do release Cypress from any claim, damage, or other liability arising from or related to all Unintended Uses of Cypress
products. You shall indemnify and hold Cypress harmless from and against all claims, costs, damages, and other liabilities,
including claims for personal injury or death, arising from or related to any Unintended Uses of Cypress products.

Cypress, the Cypress logo, Spansion, the Spansion logo, and combinations thereof, WICED, PSoC, CapSense, EZ-USB, F-
RAM, and Traveo are trademarks or registered trademarks of Cypress in the United States and other countries. For a more
complete list of Cypress trademarks, visit cypress.com. Other names and brands may be claimed as property of their respec-
tive owners.
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Safety Information

Regulatory Compliance

CY8CKIT-002 is used as a development platform for hardware or software in a laboratory. In a
domestic environment, this product may cause radio interference; adequate prevention measures
should be taken.

CY8CKIT-002, as shipped from the factory, is verified to meet with requirements of CE as a Class A
product.

General Safety Instructions 

ESD Protection

ESD can damage boards and associated components. Cypress recommends that you work on the
board at an ESD workstation, if available. Otherwise, use appropriate ESD protection, such as an
antistatic wrist strap attached to a ground, when handling parts. 

The CY8CKIT-002 boards are sensitive to electrostatic discharge (ESD).
Electrostatic charges accumulate on the human body and on other
equipment. Devices that are subjected to high-energy discharges can
suffer permanent damage. Proper ESD precautions are recommended
to prevent loss of functionality. Store unused CY8CKIT-002 boards in the
protective shipping package.
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1 Introduction

The PSoC® MiniProg3 Program and Debug Kit is an all-in-one programmer for PSoC 1, PSoC 3,
PSoC 4, PSoC 5LP, and PSoC 6 architectures, a debug tool for PSoC 3, PSoC 4, PSoC 5LP, and
PSoC 6 architectures, and an USB-I2C Bridge for debugging I2C serial connections and
communicating with PSoC devices.

Designed as a low-cost aid for developers to use in building their own systems around Cypress 8-bit
and 32-bit PSoC devices, the MiniProg3 is included with the CY8CKIT-001 development kit and sold
as a standalone kit, CY8CKIT-002. These kits are available through the Cypress Online Store or
through our distributors.

Figure 1-1.  MiniProg3

1.1 CY8CKIT-002 Contents 

The CY8CKIT-002 PSoC® MiniProg3 Program and Debug Kit includes:

■ MiniProg3 programmer/debugger

■ 10-pin ribbon cable

■ USB Standard-A to Mini-B cable

■ Quick Start Guide

1.2 Programming

The MiniProg3 programmer/debugger provides the flexibility to work with different programming and
debugging interfaces, such as JTAG, SWD, ISSP, and I2C. MiniProg3 supports all 8-bit and 32-bit
PSoC devices. When programming, MiniProg3 enables communication with target devices using I/O
voltage levels from 1.5 V to 5.5 V. In addition, MiniProg3 can supply power to a simple target board
at one of four voltage levels: 1.8 V, 2.5 V, 3.3 V, or 5 V.

http://www.cypress.com/CY8CKIT-002
http://www.cypress.com/cypress-store
http://www.cypress.com/go/CY8CKIT-001
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1.3 Debugging

MiniProg3 supports the following debugging protocols for 8-bit and 32-bit PSoC devices:

■ SWD (PSoC 3, PSoC 4, PSoC 5LP, PSoC 6)

■ JTAG (PSoC 3, PSoC 5LP, PSoC 6)

■ I2C (limited PSoC 1 devices)

The MiniProg3 debugger is supported by the software tools PSoC Creator and PSoC Designer.

1.4 Bridging

MiniProg3 supports USB-I2C bridging protocols. These protocols are used for debugging certain
PSoC 1 devices that support serial communication debugging, tuning, and configuration of fixed
function devices. The MiniProg3 bridging capabilities are used by PSoC Designer, PSoC Creator,
PSoC Programmer, Bridge Control Panel, and other applications. Tuning software tools also use
these capabilities.

Note: If you want to develop your custom USB-I2C applications using MiniProg3, see the PSoC

Programmer COM guide and examples of the custom USB-I2C applications.

1.5 Documentation Conventions

Table 1-1.  Document Conventions for User Guides

Convention Usage

Courier New
Displays file locations, user-entered text, and source code:
C:\...cd\icc\

Italics
Displays file names and reference documentation:
Read about the sourcefile.hex file in the PSoC Designer User Guide.

[Bracketed, Bold]
Displays keyboard commands in procedures:
[Enter] or [Ctrl] [C]

File > Open
Represents menu paths:
File > Open > New Project

Bold
Displays commands, menu paths, and icon names in procedures:
Click the File menu, and then click Open.

Times New Roman
Displays an equation:
2 + 2 = 4

Text in gray boxes Describes cautions or unique functionality of the product.

http://www.cypress.com/psoccreator
http://www.cypress.com/psocdesigner
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2. Installing MiniProg3

This chapter shows how to install MiniProg3 and its associated PC software.

2.1 MiniProg3

Figure 2-1.  Top View

Figure 2-2.  Bottom View

2.2 MiniProg3 Installation

The MiniProg3 programmer/debugger is supported by PSoC Programmer, PSoC Designer, and
PSoC Creator. Secondary software, such as Bridge Control Panel and Clock Programmer, use the
programmer COM hardware layer to support MiniProg3 functionality.

1. Download and install PSoC Programmer. Follow the on-screen instructions to install the software.

2. Connect the MiniProg3 to your computer’s USB port using the USB cable. When properly 
connected, the four LEDs on the MiniProg3 flicker.

The first MiniProg3 driver is automatically installed.

Note: Remove the warning sticker before using MiniProg3.

3. Run PSoC Programmer: Select Start > All Programs > Cypress > PSoC Programmer 
<version> > PSoC Programmer <version>. 

When PSoC Programmer opens, the second MiniProg3 driver is automatically installed.

USB MiniProg3 
Connector

Busy LED 10-pin JTAG/SWD 
Connector

Target Power LED

Aux LED

5-pin ISSP/I2C/SWD 
Connector

Status LED

www.cypress.com/psocprogrammer
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Figure 2-3.  PSoC Programmer: MiniProg3 Selected and Connected 

4. To connect to the port, in the Port Selection window, click the MiniProg3 device. You can also 
click Connect/Disconnect.

If the connection is successful, the green status LEDs on MiniProg3 light up and a blue dot 
appears next to MiniProg3 in the Port Selection box. Also, the indicator in the lower-right corner 
of the PSoC Programmer window turns green and shows Connected.

You can now use MiniProg3 and the functions it supports. 

For more information on how to use PSoC Programmer, see Help Topics under the Help menu in
PSoC Programmer or press [F1]. 

2.3 Example Projects

MiniProg3 is supported by PSoC Programmer, a simple GUI that connects to programming
hardware, to program and configure PSoC devices and to develop custom applications. 

Example projects and documentation are included in the PSoC Programmer installation and are
available in the PSoC Programmer installation directory:
<Install_Directory>\Programmer\Examples

The PSoC Programmer installation directory also includes documentation on how to use the
programming interface:
<Install_Directory>\Programmer\Documents
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2.4 MiniProg3 LEDs

MiniProg3 has five indicator LEDs that, when lit, indicate the following:

■ Upper Left - Busy (Red): An operation (such as programming or debugging) is in progress.

■ Lower Left - Status (Green): The device is enumerated on the USB bus. When flashing, this 
LED indicates that MiniProg3 has received USB traffic.

■ Upper Right - Target Power (Red): MiniProg3 is supplying power to the target connectors. This 
LED does not light up if power to target connectors is supplied by a source other than MiniProg3. 

■ Lower Right - Aux (Yellow): Reserved for future use.

■ Middle - No Label (Yellow): Flashes briefly during the initial configuration of the device. If it stays 
lit, this LED indicates that a configuration error has occurred. If this happens, disconnect the 
MiniProg3 from the USB port and then reconnect it.
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3. Technical Description

MiniProg3 is a protocol translation device. With MiniProg3, the PC host software can communicate
through a high-speed USB to the target device to be programmed or debugged, as shown in
Figure 3-1. The device-side communication protocol can be one of the several standards and can
occur over either of the two connectors. Table 3-1 lists the protocols that are supported by each
connector. MiniProg3 enables communication with the target devices using I/O voltage levels from
1.5 V to 5.5 V. In addition, MiniProg3 can provide power to a simple target board, at one of four
voltage levels: 1.8 V, 2.5 V, 3.3 V, or 5 V.

Figure 3-1.  System Block Diagram 

Table 3-1.  Connectors / Communication Protocol Support

Connector ISSP JTAG SWD and SWVa

a. SWV trace is available only with SWD debugging.

I2C

5-pin Supported N/A SWD Supported

10-pin N/A Supported SWD and SWV N/A

PC

MiniProg3

Target Board

USB Cable

10-pin Ribbon 
Cable or 5-pin 

Direct 
Connection
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3.1 Interfaces

3.1.1 ISSP

In-System Serial Programming (ISSP) is a Cypress legacy interface used to program the PSoC 1
family of microcontrollers. MiniProg3 supports programming PSoC 1 devices through the 5-pin
connector only.

For more information about the ISSP interface, see the PSoC 1 Technical Reference Manual.

3.1.2 JTAG

The Joint Test Action Group (JTAG) standard interface is supported by many high-end
microcontrollers, including the PSoC 3, PSoC 5LP, and PSoC 6 families. This interface allows a
daisy chain bus of multiple JTAG devices. The MiniProg3 supports programming and debugging the
PSoC 3, PSoC 5LP, and PSoC 6 devices using JTAG, through the 10-pin connector only.

3.1.3 SWD/SWV

Recent ARM-based devices have introduced a new serial debugging standard called Serial Wire
Debug (SWD). The PSoC 3, PSoC 4, PSoC 5LP, and PSoC 6 device families implement this
standard, which offers the same programming and debugging functions as JTAG except the
boundary scan and daisy chain. SWD uses fewer pins of the device than the JTAG. MiniProg3
supports programming and debugging of PSoC 3, PSoC 4, PSoC 5LP, and PSoC 6 devices, using
SWD through the 5-pin or 10-pin connector.

The Single Wire Viewer (SWV) interface, also introduced by ARM, is used for program and data
monitoring, where the firmware may output data in a method similar to “printf” debugging on PCs,
using a single pin. MiniProg3 supports monitoring of PSoC 3 and PSoC 5LP firmware, using SWV,
through the 10-pin connector and in conjunction with SWD only.

The PSoC 3, PSoC 4, PSoC 5LP, and PSoC 6 devices support the SWD programming through the
SWD lines. Before programming a PSoC 3, PSoC 4, PSoC 5LP, or PSoC 6 device, make sure you
review the electrical connection requirements in the respective device datasheet or in the PSoC 3,
PSoC 4, PSoC 5LP, and PSoC 6 device programming specifications. You can find the datasheets
and programming specifications here: 

www.cypress.com/PSoC3
www.cypress.com/PSoC4
www.cypress.com/PSoC5LP
www.cypress.com/PSoC6

3.1.4 I2C

A common serial interface standard is the I2C standard. It is mainly used for communication between
microcontrollers and other ICs on the same board, but can also be used for intersystem
communications. MiniProg3 uses an I2C multimaster host controller that allows the tool to exchange
data with I2C-enabled devices on the target board. For example, this feature may be used to tune
the CapSense® designs.

When MiniProg3 is configured in the I2C protocol mode, it enables the internal 5.6-K pull-up resistors
on the SDA and SCL lines.

http://www.cypress.com/PSoC3
http://www.cypress.com/PSoC4
http://www.cypress.com/PSoC5LP
http://www.cypress.com/PSoC6
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3.1.5 RX8

UART is another common serial interface standard. MiniProg3 uses UART (RX8), which allows the
tool to receive the data from UART (TX8)-enabled devices on the target board. Refer to the “RX8
Example (MiniProg3)” section in the Bridge Control Panel Help document for more details.

3.1.6 Reference

For more information on the PSoC 3, PSoC 4, PSoC 5LP, and PSoC 6 JTAG, SWD, and I2C
interfaces, see the PSoC 3, PSoC 4, PSoC 5LP, and PSoC 6 Technical Reference Manuals. For
more information on PSoC 1 interfaces, see the PSoC 1 Technical Reference Manual.

3.2 Connectors

3.2.1 5-Pin Connector

The 5-pin connector is configured as a single row with a 100-mil pitch. It is designed to mate with a
Molex model 22-23-2051 (straight) or 22-05-3051 (right angle) male header with a key tab. 

Figure 3-2.  5-Pin Connector with Pin Assignments 

3.2.2 10-Pin Connector

The 10-pin connector is configured as a dual row with 50-mil pitch. It is used with a ribbon cable
(provided) to mate to a similar connector on the target board. The recommended mating connectors
are the Samtec FTSH-105-01-L-DV-K (surface mount) and the FTSH-105-01-L-D-K (through hole)
or similar connectors available from other vendors. The signal assignment is shown in Figure 3-3.

When programming JTAG devices, note that MiniProg3 does not support nTRST pins.

MiniProg3 
(End View)

Mating 
Connector

SDAT

SCLK

XRES

GND

VTARG

http://www.cypress.com/search/all?f[0]=meta_type%3Atechnical_documents&f[1]=resource_meta_type%3A583&f[2]=field_related_products%3A1292&f[3]=field_related_products%3A1277
http://www.cypress.com/search/all?f[0]=meta_type%3Atechnical_documents&f[1]=resource_meta_type%3A583&f[2]=field_related_products%3A1278
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Figure 3-3.  10-Pin Connector with Pin Assignments 

Here is a summary of the protocols and related pin assignments. 

3.3 Power
The MiniProg3 requires a connection to the VDDIO supply of the target device to set the voltage
level used for communication. This is required regardless of the communication protocol and the
port selected. One of the connector’s VTARG pins must be connected to the VDDIO supply of the
target device. For PSoC 3, PSoC 4, PSoC 5LP, and PSoC 6, this is the VDDIO1 supply because this
supply is used to drive the debug pins. If you do not connect the VTARG or you connect it to the
wrong supply, MiniProg3 cannot communicate with the target device.

On boards where there is a single power supply for the entire board, MiniProg3 can, in some cases,
supply power to the board. This supply is limited to approximately 200 mA, and is protected against
excess current draw. You can select 1.8 V, 2.5 V, 3.3 V, or 5 V for the power supply voltage. The 5-V

Table 3-2.  Communication Protocol Pin Assignments

Protocol Signal 5-Pin 10-Pin

ISSP

SCLK 4

SDAT 5

XRES 3

JTAG

TMS 2

TCK 4

TDO 6

TDI 8

XRES 10

SWD / SWV

SDIO 5 2

SCK 4 4

SWVa

a. SWV trace is only available in conjunction with SWD debugging.

6

XRES 3 10

I2C
SCK 4

SDA 5

XRES

TDI

TDO

TCK

TMS

VTARG

GND

GND

GND

GND

TDI

TDO

TCK

TMS

VTARG

GND

Pin 1

Note The ribbon 
cable connector 

extends beyond the 
body of the 

connector.  Be sure 
to allow room.

GND

GND

GND



CY8CKIT-002 PSoC® MiniProg3 Program and Debug Kit Guide, Doc. # 001-59350 Rev. *H 14

Technical Description

supply may be as low as 4.25 V or as high as 5.5 V, because it is supplied directly from the USB port.
Note: Some PSoC device families do not support 5-V operation. Refer to the respective device
datasheet for supported voltage selection. 

Note: When the target voltage is set to 5 V in PSoC Programmer or PSoC Creator, MiniProg3
provides SCLK and SDAT signals at 3.3 V.

In addition to supplying power, MiniProg3 can also measure voltage on its VTARG line. The PSoC
Programmer GUI displays the VTARG voltage in the Status group box (shown in Figure 2-3 on
page 8). The accuracy of the measurement is 80–100 mV in the VTARG range 0 ≤ U ≤ 4.0 V, and a
maximum of 200 mV in the range 4.0 ≤ U ≤ 5.0. 

Note: Although ADC resolution in MiniProg3 is 20 mV, the actual accuracy is approximately 200 mV.

Some users may need to add series resistance on the VTARG domain of the target board. Table 3-3
provides the maximum series resistance values for different voltage levels. Exceeding these values
will result in an unreliable communication link.

3.3.1 Voltage Detection
MiniProg3 can detect voltages in the range of 0 V to 5 V. Many of the Cypress software tools, such
as PSoC Programmer and Bridge Control Panel, display this detected voltage in the application GUI.

Table 3-3.  Maximum Series Resistance on VTARG Domain on Target Board

VTARG LIMIT VIH DROP MAX_SERIES

5.0 V 0.9*VTARG 4.50 V 0.500 V 500 ohm

3.3 V 0.9*VTARG 2.97 V 0.330 V 330 ohm

2.5 V 0.9*VTARG 2.25 V 0.250 V 250 ohm

1.8 V 0.9*VTARG 1.62 V 0.180 V 180 ohm
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A. Appendix 

A.1 Troubleshooting

If you experience difficulty with your MiniProg3, see the following table to correct the problem. 

A.2 Regulatory Compliance Information

The CY8CKIT-002 complies with the CE-Low Voltage Directive 2006/95/EC (Europe) safety
requirement. It has been tested and verified to comply with the following electromagnetic
compatibility (EMC) regulations.

■ CISPR 22 - Emissions

■ EN 55022 Class A - Immunity (Europe)

■ CE - EMC Directive 2004/108/EC

■ CE Declaration of Conformity

Table A-1.  Troubleshooting Guide

Problem Try

LED does not blink upon power on. Make sure the MiniProg3 USB cable is properly attached to both
MiniProg3 and the computer. If you are using a hub, make sure
that the hub is properly attached to both MiniProg3 and the
computer. If you are using a self-powered hub, the power must be
properly connected. Bus-powered hubs are not recommended.

No Windows USB plug-in sound. Make sure that your computer’s sound is properly configured. If
you are using a hub, try to disconnect and reconnect the hub into
the computer. If it is a powered hub, disconnect the power and
reconnect it while the hub's USB cable is disconnected from the
computer.

Yellow light in the center of MiniProg3
stays on after connecting MiniProg3 and
after launching PSoC Programmer or
PSoC Creator.

This indicates a configuration error. Run PSoC Creator or
PSoC Programmer and try to disconnect and reconnect
MiniProg3. If the yellow light persists, verify that the USB cable is
in good condition, and that it is a high-speed certified cable. If the
condition still persists, call technical support.

Intermittent programming or debugging
failures.

Try reducing the serial clock rate. Verify that the USB cable is in
good condition, and that it is a high-speed certified cable. If the
condition still persists, call technical support.

MiniProg3 is plugged in and the LED lights
have flashed but nothing is happening.

Launch a development tool, such as PSoC Programmer,
PSoC Creator, or PSoC Designer.

MiniProg3 is the *A version and the 5-pin
and 10-pin connectors are connected to
the device. 

There is a known issue with the *A version of MiniProg3 that was
fixed in the *B revision. If you have a *A programmer, then
connect to the device individually when programming. (The
MiniProg3 revision, either *A or *B, is shown on the sticker on the
back of the device.)
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